
Contents
Introduction

The Server and the Client
Before You Start
How to use this Guide
Documentation Conventions
Support
Installing FirstClass
Installation on your Hard Disk
Overview of    FirstClass
Using FirstClass With Modems
Using FirstClass With Networks
FirstClass Basics
Using Electronic Mail
Conferencing
Attachments and File Transfers
The "FCCLIENT" DOS Directory
FirstClass Client Menus

Welcome to FirstClass, SoftArc's electronic mail, conferencing, and on-line system. This guide will help 
you install the FirstClass Client software on your Windows computer and then show you how to connect 
to a FirstClass server and start using all of the great features FirstClass offers.

FirstClass is an advanced conferencing, electronic mail, bulletin board, and online communication system
that combines superb communications with a graphical user interface. When using FirstClass, the 
graphical user interface makes sending messages and transferring files easy and quick. In addition, the 
same interface takes care of all modem and file transfer protocols automatically, so remote access is just 
as easy as network access.

With FirstClass you can...
Exchange electronic mail with other users.

Exchange mail with users on other systems 
such as the Internet.

Transfer any number of files quickly using file 
attachments.

Engage in electronic conferencing with other 
users on a variety of topics.

Dial in using a modem while retaining the full 
graphical interface of Windows.

Engage in a chat with other users online.

FirstClass was designed for computers with a graphical user interface. This means that you can find what 
you are interested in quickly, without sifting through reams of unwanted information. You can point and 
click to read a particular message or open a conference without having to sort manually through all the 
messages on a particular topic.

Nothing in FirstClass forces you to wait; you can read a message in one window, browse a conference in 
another, compose a memo in a third, and chat with another user in yet another window, all while 
transferring files in the background. FirstClass provides the ideal environment for online electronic 



communications.



The Server and the Client
FirstClass actually consists of two pieces of software: The FirstClass Server and the FirstClass Client. 
The Server is run by your Administrator; you will be running the FirstClass Client application in order to 
access the services provided by the FirstClass Server. Note that the FirstClass Client requires a 
FirstClass Server to connect to. You cannot use any of the features of FirstClass unless you are actually 
connected to a FirstClass Server. The client may be connected to the server using a number of 
communication systems, including modems and Local Area Networks.

Since this manual is for the FirstClass Client software, when we say "FirstClass" in the manual we will 
mean the FirstClass Client.



Before You Start
You should have some familiarity with the Windows graphical user interface before using FirstClass. You 
should understand terms such as mouse, drag, open, select, file, choose, and double-click. For more 
information, refer to the manuals that came with Windows.



How to use this Guide
This guide is designed to get you up and running quickly. It covers the installation and basic operation of 
FirstClass. If you have already used FirstClass, or you are an experienced Windows user, much of 
FirstClass will be familiar.



Documentation Conventions
Throughout this document, there are several conventions that you should be aware of: The names of 
application programs will be referred to using italics, e.g. the FCCLIENT.EXE application. DOS directories
and conferences are referred to using quotations, e.g. the "FCCLIENT" DOS directory or the "News" 
conference. Entries on forms are referred to as fields or boxes and are denoted using the Geneva italic 
type face, e.g. the Server name field on the Communication Setup Form. Buttons and menu items are 
referred to in italics, e.g. the File menu, the Setup button.

Finally, some information in this manual appears in more than one place. In this case, there will be a note 
referring you to the other section, and the reference will be denoted by the chevron character (»).



Support
Your Administrator should be able to solve any problems you encounter. Once you have installed 
FirstClass and have connected to the server, you may use the mail system to request assistance or report
any problems by addressing messages to the Administrator. If you are unable to install FirstClass, you will
have to use another method (e.g. phone, fax) to contact your Administrator.

In addition, SoftArc Inc. runs its own FirstClass system, SoftArc     Online  , for customer support. The system
is available twenty-four hours a day for any user to log in to and auto-register. Our conferences answer 
commonly asked questions and contain many hints and tips from experienced FirstClass users. The 
number for SoftArc Online is (416) 609-2250. You can log in as User ID "guest" with no password if you 
would like to try out the system or ask questions in public areas. Auto-registration is available so you can 
log in as yourself using your favorite User ID and password if you plan to call more than once.

We also provide support through several other electronic mail systems:
Internet

You may contact us as support@softarc.com or sales@softarc.com. We 
also have our own newsgroup, alt.bbs.first-class.

America Online
Our account is SOFTARC. We monitor America Online and also provide 
support through the Communications And Networking area.

Compuserve
Our account is 70511,2023. We also monitor MACCOMM and IBMBBS.

AppleLink
CDA0674



Installing FirstClass
The first step in using FirstClass is to install the software onto your Windows-compatible computer. 
FirstClass may be installed on almost any computer equipped with Microsoft Windows. The requirements 
are:

o A computer capable of running Windows 3.1

o Windows 3.1
Windows 3.1 must be installed on the computer before you install FirstClass.

o At least 2 megabytes (2000 KBytes) of free storage on your hard disk.
To check this, open the File Manager and click on the drive on which you will be installing 
FirstClass. The amount of available storage is shown in the bottom left corner of the File Manager
window (in this example, 32,700 KBytes or 32 megabytes):



Installation on your Hard Disk
Unless you are very short of disk space, we recommend that you install the FirstClass Client application 
on your hard disk drive. To do this, simply follow these instructions:

1. Insert the FirstClass Client diskette into your drive.

2. In the File Manager, go to the appropriate drive and double-click on the setup.exe file. The 
installation procedure begins:

3. Click the Continue button. The following dialog box prompts you to indicate which options you 
wish to install Checking Windows Help provides on-line help files for your reference.

In addition, you must enter the destination directory, where the executable and all related files will
be located. If the directory does not exist, it will automatically be created.

4. Click Install. The following window displays the progress of the installation. You can click Cancel 
at any time to cancel the installation.



5. When the installation process is complete, it automatically terminates and the following dialog 
appears.

6. Click OK. The Program Manager window is displayed, along with the FirstClass program group 
window.

Make sure that you read the release notes before running the FirstClass Client application.



Overview of    FirstClass
In order to use any of the features of FirstClass, you must make a connection from your computer to the 
FirstClass server, and then you must supply your User ID and password before the server will let you on. 
This process is known as logging in. 

Related Topics:
Settings Documents
Starting the FirstClass Application



Settings Documents
Typically, every FirstClass system you will connect to has a Settings Document. A Settings Document 
contains all of the information required for FirstClass to connect to a server. For example, if the 
connection will be made via modem the Settings Document will typically contain the phone number of the 
system. If the connection is to be made over a Local Area Network, the Settings Document typically 
contains the server name. The Settings Document may also contain additional custom items such as 
forms, icons, sounds and pictures.

Usually, your Administrator will have provided a Settings Document for you to use when connecting to the 
FirstClass Server. To find the Settings Document, simply open the "SETTINGS" DOS directory, stored in 
the "FCCLIENT" DOS directory.

If there is not a Settings Document for the system you want to connect to, you may create new Settings 
Documents, although they will lack any custom forms, etc. To create a new Settings Document, simply 
duplicate the "Generic" Settings Document and rename it as required. To duplicate a file, open the File 
Manager, click on the file and then choose Duplicate from the File menu.



Starting the FirstClass Application
To start the FirstClass Client application, open a Settings Document by double-clicking on it. As soon as 
FirstClass starts up, the Login Form is displayed:

 
From here, you login, or connect, to the FirstClass Server. The Login Form has the following controls:

User ID
Each user has a unique and private User ID. You should type your User ID 
into this box. If you do not have a User ID, you should check with your 
System Administrator. 
» The User ID is not normally saved. By using the Setup button, you may 
also store your User ID in the Settings Document for convenience. 
» Your Administrator may have enabled the Auto-register feature, which 
will allow you to log in with any User ID.

Password
Each user has a unique and private password. You should type your 
password into this box. If you have forgotten your password, you should 
check with your System Administrator. 
» The Password is not normally saved. By using the Setup button, you may 
also store your Password in the Settings Document for convenience. 
» Once you have logged on you may change your password by choosing 
Change Password from the Service menu.

Service
This field shows you the name of the Settings Document you have open.

Setup button
Clicking on the Setup button opens the Settings Form and allows you to 
change the entries that are saved in the Settings Document.

Cancel button
Clicking on the Cancel button will close the Login Form.

Login button
Clicking on the Login button will instruct FirstClass to start a connection to 
the FirstClass Server, using the current settings.

In this example, we have entered the User ID and password into the appropriate boxes.



Using FirstClass With Modems
If you will be using a modem with FirstClass to connect to an online system, you should read this chapter. 
If you will not be using modem connections you may skip this chapter

Before you start using FirstClass with a modem, you should ensure that you have set up FirstClass and 
your computer so that they will work together correctly with your particular modem. To do this, you must 
configure the Modem Connection File. Follow these steps (in this example, we will configure FirstClass to 
work with a Hayes Ultra 14.4 modem):
» For details on Connection Files, see Appendix A.

1) Ensure that you have connected your modem to your computer as 
specified in the modem documentation.

3) Choose Modem from the Connection Setup sub-menu in the Service menu:

 

4) The Connection Setup Form for the Modem Connection File will be displayed:

5) Use the Modem popup to select the type of modem that you have. In the 
example above we've chosen Hayes Ultra ("HAYSULTR.MDM"). If your modem 
does not appear in the popup, you should select Hayes 2400, Hayes 9600, or
Hayes 14400, depending on the speed of your modem.



6) Set the Port popup to the Comm port that you have your modem 
connected to (e.g. COMM1).

7) Set the Phone popup based on the type of phone line that you have (Pulse if
you have dial phones, Tone if you have Touch Tone phones).

8) As long as you have an internal modem or a standard modem cable, you 
should leave the H/W Handshake, DTR Hangup and Carrier Detect popups to 
On.

9) The Auto Speed and Baud Rate popups are set automatically when you 
select a modem. You should not change these popups.

10) Click on the Save button. This will save your settings into the Modem 
Connection File.

Once you have set up the Modem Connection File as described above, FirstClass will automatically use 
your settings when you set the Connect via popup in the Settings Form to Modem. You do not need to 
change the Modem Connection File unless you change your modem setup.

» If you want additional information about the Connection Setup Form, see Chapter 10.

Related Topics:
Checking The Settings Document
Logging In To FirstClass Using a Modem



Checking The Settings Document
The first time you use a Settings Document you should ensure that all of the settings are correct. By 
clicking on the Setup button on the Login Form or by choosing Service Setup from the Service menu the 
Settings Form is displayed:

The Settings Form will have the name of the Settings Document displayed in the title, and will also 
contain the following controls:

Connect via
The Connect via popup allows you to choose which connection method you 
will use to connect to the server. For a modem connection you should 
choose Modem. This will select the Modem Connection File that you have 
already configured.
» For details on additional choices, see the Connection Setup Form section.

Setup button
Clicking on the Setup button will display the Connection Setup Form for the
connection type selected in the Connect Via popup. 
» For details, see the Connection Setup Form section.

User ID
You may enter your User ID here to have it automatically stored in the 
Settings Document.

Password
You may enter your password here to have it automatically stored in the 
Settings Document.

Note: If other people have access to your computer, you may prefer not to save 
your UserID or Password for security reasons. If you choose not to save 
this information, you can simply type them into the box on the Login Form 
every time you open the Settings Document.

Logon Automatically
If this is checked, FirstClass will automatically log on as soon as the 
Settings Document is opened. You may disable the automatic logon by 
holding down the Control key when you open a Settings Document.



Retry, Retry Delay
If you will be connecting via modem and you receive frequent busy 
signals, you may configure FirstClass to retry automatically. The Retry box 
controls the number of retries, the Retry Delay box controls the delay 
between retries.

Server, Network
Not used for modem connections.

Phone Number
If you will be connecting to the server over a modem, you should enter the
server phone number in this box. If you are connected to an office phone 
system, you may have to enter a "9" (or other special dialing prefix) 
followed by a comma to dial out correctly.

Cancel button
Clicking on the Cancel button will close the form and discard all changes 
you have made to the Settings Document.

Save button
Clicking on the Save button will close the form and save all of the changes 
that you have made into the current Settings Document.



Logging In To FirstClass Using a Modem
Once you have started the FirstClass application by double-clicking on a Settings Document and checked
that the Settings Document is correct, you still have to connect, or log in, to the FirstClass server. To do 
this, click on the Login button. FirstClass will use the connection information stored in the Settings 
Document to connect to the server.

The steps required for FirstClass to connect to a server using a modem are complex, but since FirstClass 
takes care of automating the steps the login process is straight forward. As each step of the process is 
performed, you will be informed by the two status lines on the Login Form. The first line shows the action 
in progress, and the second line shows the commands sent to the modem and the responses from the 
modem.

FirstClass performs the login by sending commands to the modem. After each command, FirstClass waits
for an "OK" response from the modem before proceeding. When you click on the Login button, the 
following actions occur (note that if any step fails, the entire login will be stopped):

1) FirstClass uses the specified Comm port to try and reset the modem. It 
sends the modem reset command and waits for an "OK" response from the
modem.
Status Line display: "Resetting modem" followed by the reset command 
sent to the modem.

2) If the modem is reset correctly in step 1, FirstClass then sends the setup 
command to the modem. Since each modem requires a different setup, it 
is important that you have set the modem type correctly on the Modem 
Connection Setup Form (described at the beginning of this chapter).
Status line display: "Setting up modem" followed by the setup command 
sent to the modem.

3) Once the modem has been set up, FirstClass sends additional commands 
to configure the modem options (e.g. speaker on or off, etc.).
Status line display: "Sending modem options" followed by the options 
command sent to the modem

4) FirstClass then tells the modem to dial the number stored in the Settings 
Document. You should ensure that the number displayed in the status line 
is correct.
Status line display: "Dialing the number" followed by the dialing command 
sent to the modem.



5) While the modem is dialing, FirstClass waits from a "CONNECT" response 
from the modem.
Status line display: "Waiting for connection" followed by the dialing 
command sent to the modem.

Once the modem has started dialing, there are a number of possible outcomes:
1) If everything is successful, the server will answer the call and the two 

modems will connect. In this case the status line will display the message 
"Negotiating connection" and then the "Connected" message. At this point 
the User ID and password you specified will be sent to the server. If your 
User ID and password are correct, your FirstClass Desktop will be 
displayed.

2) If the server modems are all busy, the modem will report "BUSY" and the 
status line will display "Line is busy" and the login will fail.

3) If the modems are unable to connect for any reason, your modem will 
report "NO CARRIER" and the login will fail.

If the connection fails for any other reason, contact your Administrator or Technical Support.



Using FirstClass With Networks
If you will be using a Local Area Network to connect to the FirstClass server you should read this chapter. 
If you will not be using network connections you may skip this section. If you want to connect to your 
server over a Local Area Network, you must ensure that the IPX Module Option is installed in the 
FirstClass server. This will allow a connection between the Windows client and the FirstClass server over 
any Novell-compatible LAN.

Related Topics:
Setting Up IPX Connections
The Settings Form
Logging In to a FirstClass Server



Setting Up IPX Connections
Setting up access to the FirstClass server for the client PC is straightforward. The major concern is 
setting the frame type that the client PC will use.

Related Topics:
Frame Types and Protocols
Windows for Workgroups
NetWare with Windows
No Networking Software
NetWare Considerations
Multiple Entries in NET.CFG
Comm Ports, Cards, and Interrupts



Frame Types and Protocols
Novell's NetWare supports four basic protocol families, all of which allow you to run IPX over an Ethernet 
network. Each of these protocols supports a number of different Frame Types, as follows:

Protocol Compatible Frame Types 
Supported

Ethernet_II IPX, TCP/IP, AppleTalk
Ethernet_802.2 IPX, FTAM, AppleTalk
Ethernet_802.3 IPX
Ethernet_SNAP IPX, TCP/IP, AppleTalk

The FirstClass server currently supports either Ethernet_II or Ethernet_802.2 frame types, so client 
machines must be configured to support one of the two. We recommend that you use Ethernet_802.2 as 
this is the preferred protocol for NetWare. Since most PC Ethernet cards come pre-configured for 
Ethernet_802.3, you will almost certainly have to re configure your client machines, although if you run 
EtherTalk this might have been done already.

In any event, you only have to change frame types on the machines that will be running the FirstClass 
Client software. Machines not running the client software may continue to use any frame type.



Windows for Workgroups
If you are using Microsoft's Windows for Workgroups, configuration of your machine is very 
straightforward. First, you must ensure that you have an NE2000-compatible Ethernet card installed.

To configure the software, open the Program Manager window and open the Control Panel icon. Open the
Network control panel and click the Adapters button. Select the NE2000 adapter and click the Setup... 
button. Click the Protocols... button in the Setup window. You will see a list of the available protocols. 
Ensure that the protocol called "Novell IPX" has been added. Select "Novell IPX" and click the Settings... 
button. Set the Adapter Media Type to "Ethernet_II(DIX)" and click the Set button. Click OK until you are 
back at the Program manager.

Windows for Workgroups is now configured for Ethernet_II. Proceed with installation of the FirstClass 
Client for Windows software.



NetWare with Windows
There are two ways you can configure Windows to work with NetWare:

o set up NetWare on the client machine and then install Windows

or

o remove NetWare from the client machine and let the Windows installer set up the correct 
NetWare drivers.

Since there are several problems involved in the first method, this document assumes that you have 
installed NetWare using the Windows installer. If you have not already done this, do so now. Simply run 
SETUP.EXE and ensure that the Network is set to Novell Netware. If it is not, change it now.

Once you have set up the client PC to use Novell's NetWare, all you have to do is ensure that the frame 
type is set to Ethernet_II or Ethernet_802.2. You do this by changing your NET.CFG file to use either 
Ethernet_II or Ethernet_802.2 frame types. To find out what your current frame type is, type out your 
current NET.CFG file in \WINDOWS\SYSTEM. It should look similar to this, although it might have 
additional lines:

Link Driver ne2000
     Frame Ethernet_802.3

Use a text editor to change the Frame line (or, if your system does not have a NET.CFG file, create one) 
to read as follows:

Link Driver ne2000
     Frame Ethernet_802.2

_    Warning Your particular installation might have several frame types listed in the NET.CFG file. It is 
critical that the top one is either Ethernet_802.2 or Ethernet_II.

Once you have changed the frame type in the NET.CFG file, reset the PC and load the NetWare drivers 
again and test logging into your NetWare server to ensure you have made no mistakes. Then, proceed 
with installation of the FirstClass Client for Windows software.



No Networking Software
Even if you have not installed any networking software on the client PC, in fact even if you have no Novell
server at all, you may still use IPX to access your FirstClass server. Simply set up Windows as if you had 
Novell installed and install the Novell-compatible driver that accompanied your Ethernet card. Configure 
the driver to use Ethernet_II or Ethernet_802.2 as described in the previous section. Note that you can 
only do this if the appropriate driver accompanied your card.



NetWare Considerations
If you have converted any of your client machines to use Ethernet_II or Ethernet_802.2, you must ensure 
that you have added support for these protocols into your NetWare servers. If you do not do this, users on
the machines that you have converted will not be able to access NetWare services. For details on how to 
do this, see the Novell documentation.



Multiple Entries in NET.CFG
Note that if you have multiple protocols entered in your NET.CFG file you must have the 802.2 or 
Ethernet_II line at the top of the list.



Comm Ports, Cards, and Interrupts
If you have a computer with Windows installed, a serial mouse installed on COM1:, and an Ethernet card, 
you might experience interrupt conflicts if you try to use COM2: and the network card at the same time. 
The solution is to change the interrupt that the Ethernet card uses (see the documentation that 
accompanied your Ethernet card for instructions). After you change the interrupt you will have to change 
your NET.CFG file so the networking software knows about the new interrupt. Here is an example of how 
NET.CFG would look if you were to use IRQ 10:

Link Driver ne2000
Frame Ethernet_802.2
INT 10



The Settings Form
The first time you use a Settings Document you should ensure that all of the settings are correct. By 
clicking on the Setup button on the Login Form or by choosing Service Setup from the Service menu the 
Settings Form is displayed:

 

The Settings Form will have the name of the Settings Document displayed in the title, and will also 
contain the following controls:

Connect Via
The Connect Via popup allows you to choose which connection method you 
will use to connect to the server. For an AppleTalk connection you should 
choose IPX. This will select the IPX Connection File.
» For details on additional choices, see the Connection Setup Form section.

Setup button
Clicking on the Setup button will display the Connection Setup Form for the
connection type selected in the Connect Via popup. 
» For details, see the Connection Setup Form section.

User ID
You may enter your User ID here to have it automatically stored in the 
Settings Document.

Password
You may enter your password here to have it automatically stored in the 
Settings Document.

Note: If other people have access to your computer, you may prefer not to save 
your UserID or Password for security reasons. If you choose not to save 
this information, you can simply type them into the box on the Login Form 
every time you open the Settings Document.

Logon Automatically
If this is checked, FirstClass will automatically log on as soon as the 
Settings Document is opened. You may disable the automatic logon by 
holding down the Control key when you open a Settings Document.

Retry, Retry Delay
Not required for network connections.

Server, Network
Enter the server name in the Server box. See your Administrator if you 
have any questions.

Phone Number
Not used for network connections.

Cancel button
Clicking on the Cancel button will close the form and discard all changes 
you have made to the Settings Document.

Save button
Clicking on the Save button will close the form and save all of the changes 
that you have made into the current Settings Document.





Logging In to a FirstClass Server
Once you have started the FirstClass application by double-clicking on a Settings Document and ensured 
that your User ID and Password are entered in the appropriate boxes, you still have to connect, or log in, 
to the FirstClass server. To do this, click on the Login button. FirstClass will use the connection 
information stored in the Settings Document to connect to the server. After a brief negotiation your 
FirstClass Desktop will be displayed.

If you receive error 1044 ("There is no FirstClass server with that name on the network"), then you will 
have to ensure that the server Name settings are set correctly. If the Name is set correctly, or if you 
receive any other error, contact your Administrator to ensure that the server is running and that you have 
proper access to the IPX network.



FirstClass Basics
This chapter describes the FirstClass Desktop and the basic operation of the FirstClass system. The 
operation of FirstClass is the same whether you have connected by modem or network. Once the login 
has completed, your FirstClass Desktop will be displayed. The standard FirstClass desktop looks like this,
although your Administrator might have customized it:

The Desktop window is always displayed while you are connected to the FirstClass Server. The following 
important icons are displayed on your desktop:

Mailbox: Your Mailbox is where all of your 
incoming and outgoing messages are stored. 
» For details on sending and receiving mail see 
the Using Electronic Mail section. 

News: The "News" conference is a public area 
that everyone on FirstClass has access to.. 
» For details on using "News" and other 
conferences, see the Using Conferences section.

Conferences: The "Conferences" folder usually 
contains all of the conferences that you have 
access to. Your Administrator may set up a 
variety of public and private conferences.

Help: The "Help" folder contains a complete 
online help system that will give you more 
information about the FirstClass system you are 
connected to.

Each of these icons represents a folder or conference, which in turn may contain additional files, folders, 
conferences and messages. To open an icon, simply double-click on it (or click once and choose Open 
from the File menu).

Related Topics:
Mailbox, Conference & Folder Windows
Message Windows
Unread Flags
Palette



Mailbox, Conference & Folder Windows
When you open any item in FirstClass, it is displayed in a new window. When you open a Mailbox, 
conference or folder icon, the window will look similar to this:

The window is divided into two panes. The upper pane contains additional folders and conferences, while 
the lower pane contains files. Each pane may be scrolled using the scroll bar. To move the split bar, 

position the mouse over the bar and drag when the cursor changes to a cross like this: 



Message Windows
When you open any message it is displayed in a new window similar to this:

The window is divided into 
two panes. The upper pane contains envelope information, while the lower pane contains the body of the 
message. You may scroll and move the split bar as with other windows.
If you resize the message window, the next message you read will be opened in a window of the new 
size.



Unread Flags
To help you keep track of what you have read, FirstClass will display a small flag (like this    ) beside 
any conference that contains items that you have not read. In the example Desktop above, both the 
Mailbox and the "News" conference contain items that you have not read. Once you have read all items in
a conference or your Mailbox, the Unread Flag will be turned off. You may also turn off a flag by clicking 
on the flag while holding down the Control key.



Palette
FirstClass provides a Command Palette for quick and easy access to many FirstClass commands. To 
display the Command Palette, choose Palette from the View menu.



Using Electronic Mail
The FirstClass electronic mail system allows you to send messages to any other users on FirstClass.

Related Topics:
Reading Your Mail
Creating New Messages
Editing Messages
Sending Messages
Replying To Messages
Forwarding Messages
Sending Forms
Keeping Your Mailbox Tidy
Message Expiry



Reading Your Mail
When you open your Mailbox by double-clicking on the mailbox icon on your desktop, a message 
summary is displayed. Remember, you know immediately if you have new unread messages because an 
Unread Flag will be displayed beside the Mailbox icon.

 Your mailbox contains a summary of both your incoming and outgoing private messages. A busy mailbox 
might look like this: 

The summary lists the sender or recipient of the message, the size, the subject, and the date the 
message was sent or received.
The following indicators are used to draw attention to certain messages:

A solid flag indicates that the message is unread, meaning that 
you have not yet opened this message.

A hollow flag indicates that the message is unsent, 
meaning that you have created the message, but not yet 
sent it.

A file icon indicates that the message has one or more files 
attached to it. » See the chapter on attachments for more details.

bold Bold type indicates that the message is urgent.

To open any message, simply double-click on it. The message is displayed in a new window. To close the 
message window, double-click on its close box in the upper left corner.

Related Topics:
Opening the Next Unread Message



Opening the Next Unread Message
Usually, you will want to read all of your unread messages. To make this more convenient, FirstClass 
provides a shortcut to do this: simply open your Mailbox and then choose Open Unread from the 
Conference menu. FirstClass will open the next unread message in your Mailbox. Continuing to choose 
Open Unread will read all unread messages. When there are no more unread messages, FirstClass will 
beep to inform you.

Since this is a common operation, you might also find it convenient to use either the keyboard equivalent 

(Command-U) or the palette button:      



Creating New Messages
In addition to reading mail sent to you, you may also compose and send your own messages. Follow 
these steps:

1) Choose Compose from the Message menu. A new, unsent message is 
created in your Mailbox and a message window is opened. Note that your 
name is automatically entered in the From field:

2) Type a subject for the message and press Enter. The cursor moves to the To field, 
ready for you to address the message.
3) Type the name of the person you are sending the message to into the To field. When 
you press Enter or Tab, FirstClass searches for the name in its Directory.

You can enter a complete name such as "Sue Bram"; a last name only, such as 
"Chun"; or even a first name, like "Bill". If only a single matching name is found in the 
Directory, the full name replaces whatever you have typed.

If more than one name is found, FirstClass displays a list of all the names that match:



 
To choose a name from the list and enter it into the address list, scroll 
through the list until you see the name you want, click on it and then click 
on the Select button. You may also select one or more names then click on
the Select button, or use the arrow keys and press Return when the name 
you want is highlighted. As a shortcut you may double-click on a name to 
enter it in one step. 

Note: After you've entered a name, pressing the Enter key creates a new line for 
entry of another name. Pressing the Tab or down arrow key will position 
you at the next field without creating space for another name.

4) Enter names in the Cc: field if you wish to send copies of the message to 
additional users.



Editing Messages
Once you have created a new message and addressed it, you must enter the body by clicking in the 
bottom pane of the message and typing. This will use the FirstClass Editor. The FirstClass Editor provides
a full-screen WYSIWYG (what-you-see-is-what-you-get) interface that supports all the standard editor 
functions (Cut, Copy, Clear, Paste). Double-clicking in the editor will select a word; triple-clicking will 
select a paragraph. Choosing Select All from the Edit menu will select the entire body.
» As a shortcut, pressing Command-Down Arrow will move the cursor between the body and the 
envelope.

While editing in FirstClass, your text is saved to the server as you type. If there is a problem (such as a 
communications failure or a power failure), the message will be preserved in your Mailbox on the server, 
and will be ready to send when you reconnect.



Sending Messages
Once you are ready to send a message, choose Send from the Message menu. If you close the message
without sending it, FirstClass gives you the following options:

Click the Send Now button to send the message. If you don't want to send the message (perhaps you 
want to work on the message later), click the Don't Send button and the message will be kept in your 
mailbox with an unsent flag beside it. Clicking the Cancel button will allow you to continue editing the 
message.
When a message is sent, a Postmark is automatically stamped on the top right portion of the message. 
The postmark indicates that the server has received the message and has begun delivery to the 
recipients:



Replying To Messages
You can respond to any message by replying to it. When you have a message open or selected and you 
choose Reply from the Message menu, FirstClass automatically creates a new message with the From, 
Subject, To, and Cc lists filled in. "Re:" is automatically inserted before the original subject. The original 
sender is entered in the To field, and copies are sent to anyone who received the original message (you 
may delete names from the To and Cc lists by clicking on the name and pressing the Delete key).

For example, here is a message and the reply generated by choosing Reply from the Message menu. 
Note that the From, Subject and To lists are filled in automatically:

Once you have entered the body of the new message, you may send it.



Forwarding Messages
You may re-send any message to another user using the forward feature. When you have a message 
open or selected and you choose Forward from the Message menu, FirstClass automatically creates a 
new message which is a copy of the selected message (including attachments) with the From and 
Subject fields filled in. "Fwd:" is automatically inserted before the original subject.

For example, here is a message and the forwarded message generated by choosing Forward from the 
Message menu. Note that the subject has been filled in and the body had been copied from the original to
the forwarded message. Also, note that the From field lists the original sender as well as the name of the 
person who forwarded the message:

Once you have entered the recipients of the new message, you may edit the body and send it:





Sending Forms
In addition to supporting standard office-memo style messages, FirstClass also supports electronic forms.
You can compose and send forms as with normal messages, but the forms may contain fill-in fields, 
checkboxes, list boxes, etc.. Each FirstClass system includes several standardized forms to choose from,
including File Transfer, Phone Call, Request For Information, and a Requisition Form.

To send a form, choose New Form from the Message menu, then select the form you wish to send from 
the sub-menu. For example, to send a new phone message form you would choose Phone Message from
the New Form menu:

 
This would create a new Phone Message form, which you fill in, address and send as you would any 
message:

 



Keeping Your Mailbox Tidy
To keep your Mailbox tidy FirstClass allows you to file messages in folders and to delete unwanted 
messages.

Related Topics:
Using Folders
Deleting Messages



Using Folders
To clean up your Mailbox, you might want to organize some of the messages so that you can refer to 
them later on. FirstClass allows you to create folders in your Mailbox    for this purpose.

To create a folder in your Mailbox, open your Mailbox and choose New Folder from the Conference menu.
A new folder will be created in the upper pane of the current window. To rename the folder, click on the 
name and then type in the new name or select the folder and choose Get Info from the File menu.
You can create multiple folders in your Mailbox and also folders within folders. To place messages into 
folders, simply drag them into the folder using the mouse. You can also shift-click to select multiple 
messages and drag all of them into the appropriate folder.



Deleting Messages
If you receive many mail messages, your Mailbox can quickly become cluttered. To delete messages from
your Mailbox, select the messages you want deleted (shift-click to select multiple messages) and choose 
Delete from the File menu.

Before actually deleting the messages, FirstClass will ask you to verify that you want to delete the 
selected items. Click Delete to delete selected items, or Cancel to cancel the delete. Regular deletion of 
old messages is recommended in the interests of conserving disk space on the server. You can delete 
folders in exactly the same way you delete messages: highlight the folders and choose Delete from the 
File menu.

Note that FirstClass will not actually delete an message from disk until all recipients have deleted it. This 
means that you may delete items you have sent without worrying about them being deleted from the 
recipient's Mailboxes.



Message Expiry
All messages in FirstClass have an expiry date, after which they will be automatically deleted. You may 
see the expiry date of a message by selecting or opening the message and then choosing Get Info from 
the File menu. The expiry date in your Mailbox and each conference is set by your Administrator.



Conferencing
Conferences are forums or bulletin boards which are generally focused on a single topic. For example, 
there might be a conference that contains items dealing with a particular type of software, or a specific 
product, or a topic of interest. By reading these conference items, you can stay abreast of information you
are interested in.

Opening the "Conferences" icon on the desktop displays the contents of the "Conferences" Folder. In this 
folder you will find all of the public conferences that are available on your system.

® A Note about available conferences... The specific list of conferences available 
on your system will depend on the special interest groups within your user 
community. If you feel there is a need for a conference your server does 
not have, your Administrator can create a new one for you.

If you are interested in a conference, open it by double-clicking on its icon. FirstClass shows you which 
conferences contain items that you have not yet read by putting an unread flag beside the icon.

® A Note about conference information... If you are curious about the contents of 
a specific conference, you can select the conference and choose About 
Conference... from the Conference menu. This displays a window that 
contains a brief description of the conference. You may also double-click 
on the name of a conference in any message to display this information.

Related Topics:
Browsing Conferences
Replying To Messages
Following Message Threads
Sending Messages To Conferences
Forwarding Messages
Subscribing to a Conference
Private Conferences



Browsing Conferences
When you open a conference, a summary of the messages in the conference is displayed.

The conference summary is just like the display in your Mailbox. Items that you have not yet read are 
marked with an unread flag ( ) and any that have attachments are marked with an attachment flag (

).    
» See the chapter entitled File Attachments and Transfers for more details on attachments.
You may open any message in a conference by double-clicking on it, just as you can do with messages in
your Mailbox. The message will be displayed in a new window. To close the message, just click on the 
Close Box. You may continue to read messages in the conference until you have read all of the unread 
messages. When there are no more unread messages, the Unread Flag beside the conference icon will 
disappear.

Related Topics:
Opening the Next Unread Message



Opening the Next Unread Message
Usually, you will want to read all of    the unread messages in a conference. To make this more 
convenient, FirstClass provides a shortcut to do this: simply open the conference and then choose Open 
Unread from the Conference menu. FirstClass will open the next unread message in the conference. 
Continuing to choose this menu items will read all unread messages. When there are no more unread 
messages, FirstClass will beep to inform you.

Since this is a common operation, you might also find it convenient to use either the keyboard equivalent 

(Command-U) or the palette button:     



Replying To Messages
As you are browsing through a conference, you might see a message that you wish to respond to. This is 
easy to do - you just open or select the message and then choose Reply from the Message menu. 
FirstClass will create a new, unsent message in your Mailbox with the From, Subject, and To fields filled in
appropriately. You then click in the body of the message and enter your reply. When you send the 
message, it is delivered to the conference.

Related Topics:
Replying To The Sender of a Message



Replying To The Sender of a Message
When you are in a conference and you choose Reply, the To: list of the reply normally contains the name 
of the conference you are in. If you want to reply to the sender of the message rather than the 
conference, choose Reply Sender from the Reply Special sub-menu (in the Message menu).



Following Message Threads
As users discuss various topics in a conference, the original message and the set of replies creates a 
thread of messages on a particular topic. 

Related Topics:
Next In Thread
Previous In Thread



Next In Thread
If you open the initial message and then choose Next in Thread from the Conference menu, FirstClass 
will open the next message in the thread. Choosing Next in Thread again will open then next message, 
and choosing it again will open the last message. If you choose Next in Thread again and there are no 
more messages in the thread, FirstClass will notify you with a beep. Since this is a common operation, 
you might also find it convenient to use either the keyboard equivalent (the F2 key) or the palette button:   

 



Previous In Thread
The threading feature will also work in reverse, to take you to the previous message in the thread. This is 
especially useful when you read a message in the middle of a thread, but the message does not have 
enough information to give you the context.

Suppose you opened the last message in the thread. To open the previous message in the thread, hold 
down the Control key before pulling down the Conference menu and choosing Next in Thread. 

Since this is a common operation, you might also find it convenient to use either the keyboard equivalent 

(Control-F2) or the palette button:      



Sending Messages To Conferences
To send a new message to a conference, simply open the conference and then choose New from the 
Message menu. A new, unsent message will be created in your Mailbox, with the To name already filled in
with the conference name.

For example, if you opened the "Customer Support" conference and chose New, the following unsent 
message would open on your screen. Note that it is pre-addressed to "Customer Support"

After you have entered the subject and the body of the message, send the message and it will be 
delivered to the conference:



Forwarding Messages
You may forward conference messages to other users or conferences. Simply open or select the 
message you want to forward and then choose Forward from the Message menu. FirstClass will duplicate
the contents of the message, including attachments. The new message has an empty envelope. After you
fill in the envelope information you may edit the body text and then send it.



Subscribing to a Conference
If you use a particular conference frequently you may wish to subscribe to it, which places a copy of the 
conference icon onto your desktop, so that you can open the conference directly from your desktop. 
Subscribing to a conference is a simple way of keeping a watch on the conferences that are of the most 
interest to you. Instead of navigating through various conferences and sub-conferences, you can just 
double-click on the alias on your desktop, which will open the conference.

If there are unread items in the conference, the unread flag is displayed next to the alias, which makes it 
easier to find new items. Rather than having to go and look at each conference individually, by 
subscribing you will be able to tell at a glance which conferences have new messages.    

To make an alias to a conference, click on the conference and then choose Make Alias from the 
Conference menu. An alias of the conference will appear on your Desktop.

Here is an example: The "Customer Support" conference on the Veritec BBS system is in the 
"Conferences" folder. If you are interested in the "Customer Support" conference, it is much more 
convenient to have an alias of the conference right on your Desktop than to manually open layers of 
conferences. To do this, click on the "Customer Support" conference and then choose Make Alias from 
the Conference menu. An alias of the conference will appear on your desktop:

In this example, the conference has an unread flag to indicate that the conference contains some new 
items. You may also delete an alias from your Desktop by selecting the alias and choosing Delete from 
the File menu. Deleting the alias will have no effect on the conference itself.



Private Conferences
Your Administrator might have designated certain conferences as private. If you have access to any 
private conferences, their icons will also appear on your desktop or in a special folder.



Attachments and File Transfers
FirstClass allows you to transfer or share files with other users using the attachment feature.    When you 
compose a message, you can attach any file stored in your computer to the message. You then send the 
message as usual. When you read a message with attachments, you can transfer any of the attachments 
to your computer. A powerful feature of FirstClass is that attachments work well with both private mail and 
conferences. This means that you can easily distribute files to large numbers of users.

Since you are using FirstClass to transfer the files, there is no need to worry about the type of file you are 
transferring or what type of file transfer is being used - you just attach the file. FirstClass file transfers 
work just the same whether you are connected over a modem or a network, and they even work if the 
recipient is on another type of computer, such as a Macintosh or DOS computer.

Related Topics:
Background File Transfers
Reading Messages With Attachments
Sending Messages With Attachments
Viewing Attachments



Background File Transfers
When you are transferring a file from your computer to the FirstClass server or transferring a file from the 
server to your computer, FirstClass performs the transfers in the background. This means that even while 
a file transfer is in progress, you may continue to use all features of FirstClass, even if you are connected 
over a modem.



Reading Messages With Attachments

If a message has any attached files an attachment icon ( ) will be displayed beside the message in 
the summary list and an Attachments list appears in the envelope. For example, the "Customer Support" 
conference might have the following message in it. Note that there are two files attached to the message:

To save an attachment from the server to your computer, select the attachment and then choose Save 
Attachment from the File men (as a shortcut, you may also double-click on the attachment). A dialog will 
come up and allow you to choose the destination folder and filename on your Macintosh (the standard 
folder is the "DOWNLOAD" DOS directory inside the "FCCLIENT" DOS directory). Click Save and the file 
transfer from the server to your computer will begin. Note that he time required for the transfer varies 
depending on the size of the file and the speed of your connection:

The File Transfer Progress window displays the status of the file transfer. When the transfer is complete, 
this window disappears. (Note that you can move this window by dragging it). Closing this window will 
cancel the file transfer. Remember, You can continue to use all of the features of FirstClass even while a 
file transfer is in progress. If you cancel a file transfer before it is finished, you can restart the transfer by 
downloading to the same file and choosing Replace. Only the remaining data will be transferred.



Sending Messages With Attachments
To send a file to another user or a conference, compose a new message as usual. To add an attachment 
to the unsent message, choose Attach from the File menu. You will be prompted to select the file that you 
want to attach.    Select the file you want to attach and then click on the Save button to transfer the file 
from your computer to the server. The time required for the transfer will vary depending on the size of the 
file and the speed of your connection.

While the file is being transferred, the File Transfer Progress window is displayed. You can continue to 
use all of the features of FirstClass even while the file transfer is in progress. When the transfer 
completes, the attachment will be listed in the envelope of the message. You can attach as many files as 
you wish. If you make a mistake, you can delete an attachment by selecting it and then pressing the 
Delete key.

If you are sending attachments that will be downloaded by users logged on with modems, or if you are 
using a modem, you should consider using a compression utility such as PKZIP. Compressing files will 
allow them to be sent faster, thereby reducing the duration of your phone calls.



Viewing Attachments
If the attachment is a picture or text file you can view it online by selecting it, holding down the Control 
key, and choosing Save Attachment from the File menu (or just holding down the Option key and double-
clicking on the attachment). The attachment displays in a new window.



The "FCCLIENT" DOS Directory
The FirstClass Client application exists inside the "FCCLIENT" DOS directory on your hard disk. After you
have installed the FirstClass Client, the directory will look like this:

The folder contains the FCCLIENT.EXE application, as well as a number of other files and DOS 
directories that are required for FirstClass to run correctly.

Important The FCCLIENT.EXE application must be in the same folder as the 
"SETTINGS", "MODEMS", "FCP" and "SCRIPTS" DOS directories. If you 
move the client application to another folder, you will be unable to successfully
run FirstClass.

Related Topics:
The "SETTINGS" DOS Directory
The "FCP" DOS Directory
The "DOWNLOAD" DOS Directory
The "MODEMS" DOS Directory
The "SCRIPTS" DOS Directory
The "FCCLIENT.LOG" File
The "README.TXT" File
The "MODEMS.TXT" File
The "FCCLIENT.INI" File



The "SETTINGS" DOS Directory
The "SETTINGS" Folder contains all of the FirstClass Settings Documents supplied with the FirstClass 
Client. Each Settings Document contains the information required to connect to a particular FirstClass 
Server, such as the phone number or network name. The Settings Documents also contain any custom 
forms, sounds, icons and pictures that the Administrator has supplied. Finally, the Settings Document 
contains the name of the Connection File that will be used to make the connection to the FirstClass 
server.

If you want to call a system for which you have no Settings Document, you may duplicate the "Generic 
Modem" or "Generic Network" file and rename the duplicate.



The "FCP" DOS Directory
In order to use FirstClass, the FirstClass Client must make a connection to the FirstClass Server. This 
connection may be made in a number of ways, including modem, IPX, etc.

Every possible connection type is controlled by a Connection File. The "FCP" DOS directory is a 
collection of Connection Files for most of the common connection types. Each file is named with the name
of the connection followed by ".FCP". When you initially install a Settings Document, you should choose 
the connection method you will use by choosing the appropriate Connection File from the Connect Via 
popup on the Settings Form. 

Related Topics:
Editing Connection Files
Connection
Cable Options
Speed Options
Advanced Settings



Editing Connection Files
To edit a Connection File, select it using the Connect Via popup and then click on the Setup button. The 
basic Connection Setup Form will be displayed, with additional fields based on the actual connection 
protocol. 

The name of the Connection File being edited is displayed at the top of the form. The Cancel button will 
close form without saving changes to Connection File, while the Save button will close form and save 
changes to FCP file.

Remember that the Connection File will be opened and used for all Settings Documents which are set to 
use that connection. For example, if you change the "MODEM.FCP" Connection File to turn off the 
speaker, then the speaker will be off for all Settings Documents which use "MODEM.FCP". If you need to 
have two different connection settings then you will need to create an additional Connection File and set it
up appropriately. For example, you might want the speaker on for some systems and off for others, in 
which case you would duplicate "MODEM.FCP", rename it "QUIET.FCP", turn the speaker off in 
"QUIET.FCP", and then select the appropriate Connection File in each Settings Document ("QUIET.FCP" 
or "MODEM.FCP").

The Connection Setup Form looks like this:

Protocol
The Protocol popup allows you to choose the actual communication 
method that this Connection File will instruct FirstClass to    use to connect 
to the server. Choices are

Serial
Use a serial Comm port to access the FirstClass Server.

IPX
Use an IPX Local Area Network to access the FirstClass Server.



Connection 
The Connection area on the form is displayed only when Protocol is set to Serial:
Modem
Allows you to choose the Modem File for the modem you will be using. This popup will list all available 
modem settings (from the "MODEMS" DOS directory).
Port
Allows you to choose which serial Comm port you will be using.

Phone
Allows you to choose between Tone and Pulse dial.

Speaker
Allows you to choose between modem speaker on or off.

Script
Each Connection File may have an associated script file. Normally this should be left at "-". For details, 
see the section on scripts later in this chapter.



Cable Options
The Cable Options section allows you to describe what kind of cable you have connecting your computer 
and your modem. As long as you have an internal modem or a standard RS-232 cable, you should leave 
all of these options turned On.
H/W Handshake
When you are using a modem with either compression or error correction, the computer is able to send 
information to the modem faster than the modem is capable of sending it. For example, if there is an error
in transmission the modem will have to retransmit the data, and while the retransmission is in progress 
the modem needs to tell the computer to stop sending data. This process of informing the computer to 
stop and start sending data is called handshaking.

There are two types of handshaking, hardware handshaking (also called RTS/CTS) and software 
handshaking (also called XON/XOFF). Software handshaking cannot be used with FirstClass. In 
order to use Hardware Handshaking, you must have a cable that connects the hardware handshaking pin 
on the computer to the hardware handshaking pin on the modem . 

Turning this checkbox on will instruct the computer to use hardware handshaking, and it will also send the
appropriate option commands to the modem to instruct it to use hardware handshaking. If you turn this 
checkbox on and you do not have a proper RS-232 cable, FirstClass will tell you that it is unable to get a 
response from the modem, because it will never receive the handshaking signal from the modem.
DTR Hangup
Normally, when you log off of the server while using a modem FirstClass hangs up the modem by sending
the Attention command to the modem followed by the Hangup command. A faster way to hang up the 
modem is to use the DTR pin on the modem. If you have a proper RS-232 cable or an internal modem, 
you may turn on this checkbox. This will instruct your computer to use the DTR pin to hang the modem 
up, and it will also send the appropriate option command to the modem to instruct it to monitor the DTR 
pin. If you turn on this checkbox and you do not have a proper cable, FirstClass will continue to use the 
Hangup Command.
Carrier Detect
Normally, your computer has no way of knowing whether the modem is connected to the server. 
FirstClass simply sends out commands and waits for a response from the server. If FirstClass gets no 
response from the server, it knows that the modem is no longer connected.

Although this method works, it is slow to detect a dropped connection. You may enable a faster for of 
detection by using the Carrier Detection feature in your modem. When this feature is enabled, the modem
will turn on the Carrier Detect pin to inform the Macintosh that it is connected to the server. If the 
connection is dropped for any reason, the server will turn the pin off.

In order to use this feature, you must have a proper RS-232 cable or an internal modem. When this box is
checked, FirstClass instruct your computer to monitor the Carrier Detect pin, and it will also send the 
appropriate option command to the modem to instruct it to enable the Carrier Detection feature. If you turn
on this checkbox and you do not have a proper cable, FirstClass will continue to use timeouts to detect 
loss of connection.



Speed Options
Auto Speed

If this is On, FirstClass will set the serial port speed to match the speed 
reported in the "CONNECT" report from the modem. If this is Off, FirstClass 
will ignore the speed in the "CONNECT" report. For example, if Auto Speed 
is On and the modem reports "CONNECT 2400", FirstClass will set the 
serial port speed to 2400 baud. If AutoSpeed is off,. FirstClass will leave 
the serial port speed unchanged. The setting of this popup is 
determined by the modem type. Do not change this without 
referring to your modem documentation.

Baud Rate
The baud rate that FirstClass will use when initially talking to the modem . 
The setting of this popup is determined by the modem type. Do 
not change this without referring to your modem documentation.



Advanced Settings
Click on the triangle to access advanced connection settings. These settings are designed for 
experienced users only.

Trace
Checking any of the Trace options will instruct FirstClass to save the 
specified actions in the "FCCLIENT.LOG" file, as well as displaying them in a
trace window. Note that in order for any of the trace options to have effect,
the INI file must have the line "DEBUG=1" added to it.

Receive
Trace all received packets.

Send
Trace all sent packets.

Errors
Trace all packet errors.

Connect
Trace all connection messages.

Modem/Scripts
Trace all modem and scripting commands.

Window
FirstClass uses a sliding window protocol, which allows for efficient data transfer even over long 
connection paths. If you are connected over a line with long delays (e.g. Wide Area Network, satellite link)
you should set this to 8. If you are connected over a very slow link with little or no delay (e.g. 2400 baud 
modem connection) you should set this to 4.
Packets
This popup allows you to set the maximum packet size. Larger packets are more efficient, but will slow 
down response to other commands while file transfers are in progress. It is recommended that you use 
232 byte packets for 2400 baud modems and 512 byte packets for 9600 and 14,400 baud modems and 
networks. If this is set to Auto FirstClass will select the size based on the modem speed.
Lock
Normally, when FirstClass encounters errors in transmission it will shorten the size of the packets. If this 
popup is set the packets will be locked at the size specified.
Encrypt
If this is set then FirstClass will encrypt all data being passed between the client and server. In general, 
this is only required on networks. In addition, modems will be unable to compress encrypted data, so this 
should not be turned on if you are using a V.42bis (compression) modem connection.



The "DOWNLOAD" DOS Directory
When you transfer a file from the FirstClass Server to your computer, FirstClass will ask you where on 
your computer you want the file saved. The standard choice is to place the file in this folder.



The "MODEMS" DOS Directory
Every modem is controlled by sending it a series of commands, but almost all modems use slightly 
different commands. The "MODEMS" DOS directory is a collection of command files for most of the 
popular modems. Each file (called a Modem File) is named with the name of the modem followed by 
".MDM". When you set up the Modem Connection File ("MODEM.FCP"), you must select your modem 
from the list.

Related Topics:
Content of the Modem Files
Adding New Modems



Content of the Modem Files
Each Modem File consists of a list of command keywords followed by the actual commands for the 
particular modem defined by the file. For example, the Hayes Ultra Modem File ("HAYSULTR.MDM") 
looks like this:

Each non-numeric command must be surrounded by quotes, and all occurrences of "\r" are replaced with 
a Return.
The command keywords are:

MNAME
The modem name.

MDMATT
The Attention command. Sent to the modem to place it into command 
mode.

MDMDIAL
The dial command. Sent to the modem when a number is dialed. The "%s" 
is replaced by the number being dialed.

MDMTONE
The dial modifier for Touch Tone dialing. This command is placed at the 
beginning of the number being dialed before the number is placed into the
MDMDIAL command.

MDMPULSE
The dial modifier for pulse (rotary) dialing. This command is placed at the 
beginning of the number being dialed before the number is placed into the
MDMDIAL command.



MDMHUP
The hangup command. Sent to the modem to force it to hang up.

MDMANS
The answer command.

MLTO
Long Timeout, in 1/60th of a second intervals. The amount of time the 
modem will wait between starting to dial a number and receiving a 
response.

MSTO
Short Timeout, in 1/60th of a second intervals. The amount of time 
FirstClass will wait between sending a command and receiving "OK" back 
from the modem. If FirstClass does not receive an "OK" within this time, it 
will display a timeout error.

MDMRESET
The modem reset command. Sent to the modem at the beginning of every 
login. The reset should perform the basic modem configuration.

MDMINIT
The modem initialization command. Sent to the modem immediately 
following the reset command. This command should perform additional 
modem configuration.

MDMOPT
The modem options command. Depending on the checkboxes on the 
Connection Setup Form, the "%s" will be replaced with the following 
values:

MDMHWHS
Hardware Handshaking command. Sent to the modem to instruct it to use 
hardware handshaking. If H/W Handshake is On, this will be added to the 
"%s" in the MDMOPT command.

MDMSPKR
Speaker On command. Sent to the modem to instruct it to turn on the 
speaker. If Speaker is On, this will be added to the "%s" in the MDMOPT 
command.

MDMDCD
Carrier Detection command. Sent to the modem to enable the Carrier 
Detect pin. If Carrier Detect is On, this will be added to the "%s" in the 
MDMOPT command.

MDMDTR
DTR Hangup Command. Sent to the modem to enable DTR Hangup. If DTR 
Hangup is On, this will be added to the "%s" in the MDMOPT command.

MBAUD
The baud rate that FirstClass will use when initially talking to the modem 
when the H/W Handshake popup is Off.



MHWHSBAUD
The baud rate that FirstClass will use when initially talking to the modem 
when the H/W Handshake popup is On.

MAUTOSPEED
If this is set to 1, FirstClass will set the serial port speed to match the 
speed reported in the "CONNECT" report from the modem. If this is 0, 
FirstClass will ignore the speed in the "CONNECT" report. For example, if 
AutoSpeed is On and the modem reports "CONNECT 2400", FirstClass will 
set the serial port speed to 2400 baud. If AutoSpeed is off, FirstClass will 
leave the serial port speed unchanged.

MCOMMENTS
Comments on the modem. Displayed on the Connection Setup Form when 
the modem is selected.



Adding New Modems
If you receive additional Modem Files, you need only drop them in the "MODEMS" DOS directory and 
they will immediately appear in the Modem popup on the Connection Setup Form.

You may also create your own new Modem Files by duplicating an existing file, renaming it, and using the
manual that accompanied your modem to enter the commands correctly.



The "SCRIPTS" DOS Directory
Each Connection File may have an optional script associated with it. The script will be executed after the 
standard FirstClass modem handling has run. The Script Files are stored in the "SCRIPTS" DOS directory
and all end in ".FCL".

Remember that the name of the script in use is stored on the Connection File, so selecting a script will 
instruct FirstClass to use the script in all Settings documents that use that Connection File.



The "FCCLIENT.LOG" File
If the "FCCLIENT.INI" file contains the line "DEBUG=1", a new "FCCLIENT.LOG" file is created in the 
working directory whenever the FirstClass Client application is run. This file contains log information. To 
control what information goes into the log file, use the Trace checkboxes in the Advanced Settings section
of the Communication Setup Form.



The "README.TXT" File
The "README.TXT" file is included to document any changes to the operation of FirstClass since this 
manual was printed. You should read it after installing FirstClass.



The "MODEMS.TXT" File
The "MODEMS.TXT" file contains additional information about modems that may have changed since this
manual was printed. You should read it if you will be using a modem to connect to the FirstClass Server.



The "FCCLIENT.INI" File
The "FCCLIENT.INI" file (stored in the Windows DOS directory) contains commands to control basic 
operation of the FCCLIENT.EXE application. A typical FCCLIENT.INI file looks like this:

The FCCLIENT.INI file is divided into two sections: The FCSetup section and the FileTypes section.

Related Topics:
The FCSetup Section
The FileTypes section



The FCSetup Section
The FCSetup section of the FCCLIENT.INI file must start with the line "[FCSetup]" (see the example 
above for details). There are four possible entries in the FCSetup section:
Magnification
The magnification setting will control the size of the windows and text within FirstClass. A magnification of 
100 will assume a 72 dot pitch monitor. If your windows are too small, increase this number. If your 
windows are too large, decrease this number. In the example above, the magnification is set to 80 (a 
good setting for a standard 640 X 480 VGA monitor).
Face
The Face setting will determine the typeface used within FirstClass. You may use any of the typefaces 
available on your computer (to get a list of available typefaces, choose Font... from the Options menu in 
the File Manager. If possible, you should choose a True Type font. In the example above, the typeface 
has been set to Arial.
Debug
If this is set    to 1, a "FCCLIENT.LOG" file will be generated every time the client is run, and the 
debugging information will also be displayed on the screen. In the example above, debugging is on. If this
is set to 0 or the line is deleted, the debugging information will not be generated.



The FileTypes section
The FileTypes section is used when sending attached files from Windows computers to Macintosh 
computers. If you will not be using Macintosh computers, you may skip this section.

Windows computer use the three-letter extension to determine what application should be used to open a 
particular file. For example, ".TXT" files are opened by the Notepad Editor, ".DOC" files are opened by 
Microsoft Word, etc. The Macintosh, on the other hand, uses a special 8-letter code (called a signature) 
stored in each file to determine what application to use. For example, the signature for Microsoft Word 
files is "MSWDWDBN".

If a user on Windows sends a message with an attached file to a user on a Macintosh, the Macintosh will 
save the files with a generic "Windows file" signature. This will cause problems, because the Macintosh 
will not know how to open the file. FirstClass allows you to solve this by translating Windows extensions 
to Macintosh signatures automatically. In order to do this you must enter the Windows extension followed 
by the Macintosh signature. In the example INI file, you will see several examples.



FirstClass Client Menus
This chapter provides an overview of each of the menu items available in the FirstClass Client application.

Related Topics:
The File Menu
The Edit Menu
The Message Menu
The Conference Menu
The Service Menu
The View Menu



The File Menu
New

Create a new message. If you choose New before you are logged on it will create a new Settings 
Document.

Open
Open the selected item. You may also double-click on an item to select and open it in a single step.

Close
Close the current window. You may also double-click on the close box in the upper left corner of the 
window to close it.

Save
Save the current item on your hard disk. There is no need to save messages as they are automatically 
saved on the FirstClass server.

Upload/Attach File
Transfer a file from your computer to the FirstClass server. If the current window is a message, this menu 
item will be Attach File. If the current window is a conference or folder for which you have Upload 
permissions, the menu item will be Upload. If you do not have Upload permissions, this menu item will be 
grayed out.

Download/Save Attachment
Transfer a file from the FirstClass server to your computer. If the current window is a message, this menu 
item will be Save Attachment. If the current window is a conference or folder for which you have 
Download permissions, the menu item will be Download. If you do not have Download permissions, this 
menu item will be grayed out.

Delete
Delete the current item or any selected items. This menu item will be grayed out if you do note have 
Delete permissions.

Get Info
Display additional information about the current item or any selected items.

Search
Search the current window for information. This will be grayed out if you do not have the Search 
permissions.

Search Next
Find the next item matching the current search specifications

Page Setup
Set up the printer characteristics.

Print
Print the current window.



Quit
Exit from the FirstClass application. If you are connected via modem, FirstClass will confirm that you want
to quit.



The Edit Menu
Undo

Not implemented in this version.

Cut
Delete the selected information and place it on the clipboard.

Copy
Place the selected information on the clipboard.

Paste
Insert the information on the clipboard.

Clear
Delete the selected information.

Select All
Select everything in the current window.

Preferences
Display the Preferences Form:

Résumé
Display your résumé. Your résumé will be displayed whenever someone double-clicks on your name. You 
should enter any information you want. You may also paste a picture into the box in the upper-left corner:



The Message Menu
Compose

Create a new message. If you choose this menu item in a conference for which you have Send 
permissions, the message will be automatically addressed to the conference.

New Form
Create a new message form. If you choose this menu item in a conference for which you have Send 
permissions, the message will be automatically addressed to the conference.

Reply
Create a message as a reply of the current message or any messages selected in current window. 
Replies to messages in your mailbox will be addressed to all recipients, while replies to messages in 
conferences will be addressed to that conference only. You may also choose to reply to selected 
addressees using the Reply Special command.

Reply Special
Reply All
Address the reply to all recipients of the original message.

Reply Sender
Address the reply only to the sender of the original message.

Reply Conference
Reply only to the conferences in the address of the original message.

Forward
Create a message which is an exact copy of the current message or any messages selected in current 
window. You may the address and send the new message. If you do not have the Forward privilege this 
menu item will be grayed out.

Send
Send the current message. This will be grayed out of the current item is not a message or if the current 
item has already been sent.

Unsend
Retract the open or selected message. If you do not have the Unsend privilege this menu item will be 
grayed out.

History
Display the history form for the open or selected message. If you do not have the View History permission
this menu item will be grayed out.

Unread
Toggle the Unread Flag on the open message or the selected messages in the current window. You are 
only able to do this if you have the Make Read privilege.

Priority
Set the priority of the open message. The priority is used to control the behavior of mail sent through 
gateways as well as the display of the message in the recipient's mailbox. Possible priorities are:

Normal



This is the standard setting.

Urgent
Display the message subject in bold and use special gateway handling.

Bulk
Used for some gateways. See your gateway documentation.

Sensitivity
Used for some gateways. See your gateway documentation.

Receipt
Turning receipting on will automatically generate receipt messages when certain events happen. 
Receipting options are:

On Read
Generate a receipt when the recipient reads the message.

On Delivery
Generate a receipt when the message is delivered to the recipient (useful when the recipient is on 
another server).

On Route
Generate a receipt in each stage of the delivery of multi-hop mail. Useful for detecting problems is multi-
server mail systems.

Suppress NDN
Stop this message from generating Non-Deliverable Notices (NDNs).



The Conference Menu
Open Unread

Open the next unread item in the current window.

Next in Thread
Open the next message in the current thread.

New Conference
Create a new conference. If you do not have the Create Conference permissions this menu item will be 
grayed out.

New Folder
Create a new folder in the current window.

Make Alias
Make an alias of the currently selected conference and place the alias on the FirstClass Desktop.

Permissions
Display the Permissions Form of the currently open or selected conference. If you do not have the Display
Conference Permission permission this menu item will be grayed out.

Approve
Approve the selected or current message. If you do not have the Approver permission this menu item will 
be grayed out.

About Conference
Display information about the selected or current conference.



The Service Menu
Connect/Disconnect

If you are not connected to a FirstClass Server, choosing this menu item will initiate a connection using 
the connection method you have chosen. If you are already connected, choosing this menu item will 
disconnect you from the FirstClass Server.

Setup
Choosing this menu item will display the Settings Form for the Settings Document you have open.

Connection Setup
Choosing a connection type from this sub-menu item will display the Connection Setup Form for that 
Connection File.

Directory
Choosing this menu item will display a window that allows you to display names in the FirstClass System 
Directory.

Who's Online's Online
Display a list of all users logged on to the FirstClass Server.

Private Chat
Initiate a private chat with one or more users. Once the Chat Window is open, you may invite other users 
into the chat using the Invite button.

Change Password
Change your password.



The View Menu
by Icon

Display entries in the current window using icons.

by Date
Display entries in the current window as a list sorted in date order, with the oldest item at the top.

by Name
Display entries in the current window as a list sorted in alphabetical order of the sender's name.

by Subject
Display entries in the current window as a list sorted in alphabetical order of the subject.

by Size
Display entries in the current window as a list sorted in order of the increasing size.

by Status
Display entries in the current window as a list. Outgoing messages will be displayed at the top, incoming 
at the bottom. Within each set of messages, urgent messages will be displayed at the bottom, and within 
these divisions messages will be displayed by date.

Reverse Sort
Change all of the above sort orders to the reverse order. Dates will be displayed with the latest message 
first, alphabetic will be displayed starting with "z", size will be displayed with the largest first, and status 
will be displayed with the newest urgent messages at the top.

Clean Up Icons
Arrange the selected icons on a grid in the current window.

Zoom
Expand the current window to uncover all icons.

Tile
Make all open windows the same size and tile them on the available screen.

Stack
Stack all of the windows in the upper-left corner of the screen.

Session Status
Display the session status window:

Palette
Display the palette.

Desktop
Make the FirstClass Desktop the current window.



Glossary of Terms
ANSI
AppleTalk
Banyan
Baud
BBS
CCITT
CompuServe
Ethernet
FCP
Internet
IPX
ISO
LAN Manager
Mailbox
Microsoft
MNP
NetWare
Novell
SoftArc
SoftArc Online
TCP/IP
User ID
V.32bis
V.42bis
Vines
X.400
X.500



ANSI
American National Standards Institute.



AppleTalk
Networking system built into Macintosh computers.



Banyan
Developer of the Vines network operating system.



Baud
Measurement of the speeds of modems.    Roughly equivelant to the number of bits per second.    For 
example,    2400 baud would correspond to 2400 bits which is the equivelant to 300 characters (each 
character comprises 8 bits).



BBS
Bulletin Board System.



CCITT
Comite Consultatif Internationale Telegraphie et Telephone.    An international standards group 
responsible for creating many computer and communication standards such as X.400 and X.500.



CompuServe
The largest online service in the world.



Ethernet
Network protocol developed by Xerox.



FCP
FirstClass Protocol: the protocol that is used between FirstClass Clients and Servers.



Internet
Large international network running between many universities, corporations, and government research 
departments.    Uses mainly TCP/IP protocols.



IPX
(I)nternet (P)acket E(X)change: A network communication protocol used by Novell's NetWare.



ISO
International Standards Organization.    Another standards organization (similar to CCITT and ANSI).



LAN Manager
Network operating system similar to NetWare and Vines. Developed by Microsoft



Mailbox
Located on your FirstClass desktop.    Holds all your incoming and outgoing electronic mail.



Microsoft
Leading software developer and publisher of DOS, MS Windows, LAN Manager, MS Word, and MS 
Excel.



MNP
Microcom Networking Protocol. An error correction protocol for modems developed by Microcom.



NetWare
The most popular network operating system.    Developed by Novell.



Novell
Developer of NetWare, the leading network operating system in the world.



SoftArc
The developers of FirstClass.



SoftArc Online
SoftArc Online is the customer support board for FirstClass.    The number for SoftArc Online is (416) 609-
2250.



TCP/IP
Transmission Control Protocol/Internet Protocol: one of the most popular networking protocols.



User ID
Every user on FirstClass has a unique User ID.    To login to Firstclass, you must first enter your User ID 
and then your password before being connected.



V.32bis
The CCITT standard for modems communicating at speed of up to 14,400 baud.



V.42bis
The CCITT data compression standard.    Theoretical compression of up to 4 to 1 but realistically only 2 to
1.    If files are already compressed, then it has no effect and can actually increase file transmission times.



Vines
Network operating system similar to LAN Manager and NetWare. Developed by Banyan.



X.400
Standard developed by the CCITT for electronic mail structure.    Popular in Europe but less so in the USA
and Canada.



X.500
The directory services component of the X.400 standard.




